
Selvrettende opgaver med Maple

SciMath Consulting

Juli 2023



Indhold

Introduktion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Grundlaget . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Om brugen af selvrettende opgaver . . . . . . . . . . . . . . . . . . . . . . . . 4
Metode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Forberedelsen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Opgave-dokumentet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Elevens arbejdsdokument . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Valget af opgave og svarmulighed . . . . . . . . . . . . . . . . . . . . . . . . . 6
Opgave 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Hvor skal vi hen? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Opgave 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Opgave 3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Opgave 4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Et par ord om tid og forberedelse af opgaver . . . . . . . . . . . . . . . . . . . 15
Opgave 5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Opgave 6 (en opgave til dig) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Opgave 7 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Løs en ligning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Prøv igen med en ny opgave . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Opgave 1 igen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Slutord . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Alle opgaverne samlet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

2



Introduktion

De fleste undervisere vil være enige i, at i den ideelle verden kommer eleverne forberedte
til undervisningen, parate til at engagere sig aktivt i læringsprocessen - aktiv læring
forstås her som en metode, der fremmer og hjælper elevernes læring, ved at eleven i eget
tempo skaber sammenhæng og mening i deres viden.

Denne korte booklet vil vise, at selvrettende opgaver baseret på forberedt og allerede
gennemgået materiale, er et af værktøjerne der motiverer elevens egen aktive læring.

Ud over at fremme aktiv læring (f.eks. gennem diskussioner i klassen), er de selvrettende
opgaver relativt tidseffektive set ud fra underviserens perspektiv. I stedet for at bruge
værdifuld tid på, at finde ud af om eleverne har løst opgaverne korrekt, kan læreren
sætte ind med at hjælpe og undervise de elever, der har brug for yderligere hjælp med
det gennemgåede stof.

Grundlaget

Denne booklet tager udgangspunkt i Maple 2023. Vi vælger i denne booklet at oprette
kommandoerne selv, og fravælger det indbyggede værktøj QuizBuilder, fordi vi er af den
mening, at uden QuizBuilderen har vi større frihed til at designe opgaverne efter vores
ønske.

QuizBuilderen er en brugerflade, hvor du kan oprette og tilpasse selvrettende opgaver
tilpasset det emne du og dine elever arbejder med lige nu. Det står dig frit for at benytte
dette værktøj, hvis du finder det anvendeligt. Det er en hurtig og nem måde, at generere
opgaver på, og du vil kunne anvende eksemplerne fra bogen.
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Vi anvender Document Mode frem for Worksheet Mode bookletten igennem, fordi vi er
af den opfattelse, at det er nemmest tilgængelige format for eleverne at arbejde med.
Document Mode er det Maple almindeligvis åbner i.

Som udgangspunkt for eksemplerne i bookletten, bruger vi et sæt af opgaver der dækker
de mest almindelige emner, som eleven skal arbejde med iflg. læseplanen for folkesko-
len 2019. Opgaveeksemplerne dækker derfor opgaver inden for emnerne tal og algebra,
geometri og måling samt statistik og sandsynlighed.

Opgaverne finder du samlet bagerst i bookletten.

Om brugen af selvrettende opgaver

Læreren udvælger og præsenterer opgaver, der har en sværhedsgrad, der svarer til ele-
vernes estimerede dygtighed.

Vi taler for at anvende computere som supplement i undervisningen, og ikke som en
erstatning for læreren, eller som et middel til, at en lærer kan undervise et større antal
af elever samtidigt. Vi finder, at det er en fordel, hvis der er flere undervisningsstrategier
i spil, og herunder kan de selvrettende opgaver i matematikundervisningen være en af
strategierne i værktøjskassen, men absolut ikke stå alene!

Jvf. læseplanen af 2019 skal eleverne have »brugerkompetencer i regneark, dynamiske
geometriprogrammer eller CAS-programmer [. . . ]. Digitale læremidler kan endvidere
vælges som didaktisk hjælpemiddel til at fremme elevens forståelse af matematikken.
De digitale læremidler didaktiseres, så elevernes forståelse af matematikken og dens an-
vendelse styrkes.«

Vi mener, at Maple er et sådan supplement til at styrke elevernes forståelse for matema-
tik! Maples multimediale brugerflade, giver mange muligheder for at eleverne aktivt kan
styre deres egen læreproces, både hvis de vælger at samarbejde eller arbejde individuelt.

Intet kommer af sig selv, eleverne skal lære didaktiske rutiner, både i forhold til at
samarbejde og til at arbejde alene. Læreren er her i centrum ved at give indholdsfyldt
feedback, og ikke lade computerens selvrettende opgaver erstatte interaktionen mellem
lærer og elever. Computeren motiverer ikke i sig selv.

Metode

I det følgende vil vi anvende 2 pakker ; Grading, der indeholder mulighederne for at skabe
de selvrettende opgaver, og skolepakken, der giver os dansksprogede begreber.

Vi skal arbejde i to dokumenter samtidigt; i et arbejdsdokument, hvor vi skaber de
opgaver eleverne skal løse, og i et dokument, der indeholder de problemer, vi ønsker at
eleverne skal arbejde med.
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Arbejdsgangen er forholdsvis simpel. Opgaven oprettes i det første dokument, og den
genererede opgave markeres og kopieres over i elevernes arbejdsdokument. På den måde
forbliver resultaterne skjulte.

Det dokument eleverne tildeles, altså elevernes arbejdsdokument, vælger vi at opdele i to
kolonner. En kolonne til opgaveformuleringen, og en kolonne til udregninger og resultat.
Kolonnerne opnås ved at anvende tabeller, hvori vi kan placere tekst, billeder, lyd og
evt. video.
Efter opgaverne er forberedte til eleverne, overføres de til den fælles onlinegruppe, eller
uploades til et fællesdrev, hvorfra eleverne kan hente og tilgå opgaverne.

Forberedelsen

Forberedelsen er ligetil. I Maple åbnes to dokumenter. Det ene dokument er der, hvor
du forbereder dine opgaver til eleverne, det andet dokument, er det du udleverer til
eleverne, som det arbejdsdokument de arbejder i.

Opgave-dokumentet

Opgavedokumentet startes op med at skrive:

with(Grading) +

↱

. . . og det var det. Efter at have afslutte med Enter (

↱

) kan du se, hvilke muligheder, du
har til rådighed.

[AbsoluteValueFunction, DiffFeedback, DiffPractice, Draw, ExponentialFunction, GetDa-
ta, GetDomain, GetExpression, GradePlot, GridPoint, Inequalities, IntFeedback, IntPra-
ctice, IsQuadraticFormula, LinearFunction, LogarithmicFunction, QuadraticFunction,
Quiz, QuizBuilder, Segment, SolveFeedback, SolvePractice]

Elevens arbejdsdokument

Elevens arbejdsark kræver en smule mere forhåndsarbejde. Først skal dokumentet hente
skolepakken automatisk. Det gør du ved at åbne elevernes arbejdsark og klikke på:

Edit → Startup Code

I det nye dialogvindue skrives følgende linje;

with(skole); (nb! semikolon!)

Afslut med at klikke på gem (disketten) og luk derefter ned for dialogvinduet. Nu har
vi sikret os, at Maple bruger danske begreber og grader frem for radianer.

nb! Det er ikke absolut nødvendigt med skolepakken, men uden skolepakken kræver det
af eleverne, at de har kendskab til begreberne på engelsk. Fravælges skolepakken, bør
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man i stedet skrive with(Statistics);, og eleven instrueres i, hvordan man omregner fra
radianer til grader.

Dernæst vælger vi at give arbejdsarket en overskrift og evt. en lille forklarende tekst der
passer til sættet; fx opgavetemaet eller evt. tidspunktet for, hvornår opgaverne bør være
løst. Det hjælper eleven med at fokusere på, hvad det er han eller hun skal beskæftige
sig med.

På forhånd har vi bestemt, hvor mange opgaver sættet, eleverne skal arbejde med, skal
omfatte. Hvis eleverne fx skal arbejde med 7 opgaver, som det er tilfældet i denne booklet,
indsættes en tabel med to kolonner og syv rækker. Venstre kolonne bruges til at beskrive
problemet eleven skal undersøge og beregne, højre kolonne bruges til udregninger og
besvarelse.

Hvis du foretrækker kolonner af variabel størrelse, kan du vælge at indsætte én række
med to kolonner ad gangen. Du indsætter en tabel, ved i at klikke på;

Insert → Table . . .

I den følgende dialog skriver du, hvor mange rækker (Rows) og kolonner (Columns) du
ønsker, fx 6 rækker og 2 kolonner. Du indsætter tabellen ved at klikke på OK.

Elevernes arbejdsark har nu følgende udseende som skitseret nedenfor, og vi er parate
til at skrive opgaverne og oprette felterne til beregningerne. Hvis det er en skabelon, du
vil benytte ofte, kan du vælge at gemme skabelonen, før vi går videre.

Valget af opgave og svarmulighed

Du kan oprette forskellige typer af opgaver i Maple, fx fra et sceenshot, billeder, små
lydfiler eller filmklip, eller opgaver du selv skriver ind. Det kommer alt sammen an på,
hvad du som underviser mener, der passer ind i din didaktik, og hvad der støtter dine
elever bedst.

Vi vil i denne booklet ikke gennemgå samtlige muligheder. Dette er en introduktion,
hvor vi gennemgår de simple muligheder som de syv opgaver bagerst i bookletten lægger
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op til.

Du har en stor palette af svarmuligheder du kan tildele eleven; skriv svaret (Fill-in-the-
blank), vælg det rigtige svar (Mutiple Choise), rigtigt eller forkert (True/False), flere
korrekte svar (Multiple Selct) og muligheden for eleven at skrive en forklaring (Mult-
Line Feedback).

Vi vil ikke gennemgå alle mulighederne, men koncentrere os om Fill-in-the-blank og
Mutiple Choise, men er overbeviste om, at kendskabet til disse to, vil give dig nok
kendskab til, at du også uden problemer, kan anvende de andre muligheder.

Opgave 1

Opgaven eleven skal løse, er et simpelt læs-forstå-udregn eksempel. Dvs. at det ikke
burde være svært for eleven at udregne opgaven, men derimod kan formuleringen, og
dermed forståelsen for, hvad man skal gøre, være den egentlige udfordring.

Opgaven lyder; Der er udsalg i en en boghandel. Peter køber 2 kriminalromaner til 45
kr. pr. stk., 5 tegneserier, hvoraf de 3 koster 39 kr. pr. stk., og de to koster 53 kr. pr.
stk.

Hvor meget betaler Peter i alt?

Før vi begynder, er det nødvendigt for os, at kende facit til opgaven! Har vi den ikke,
finder vi den let, ved at sige; (2 · 45) + (3 · 39) + (2 · 53) = 313 kr.

Med opgave og facit, har vi nu de oplysninger vi skal bruge, for at kunne sætte den
selvrettende opgave op. Vi starter med at skrive opgaven i opgavefeltet i opgavearket, i
venstre side af tabellen.

Derefter skifter vi over til opgavedokumentet, dvs. det dokument, hvor vi koder opgaven
og dets svarmulighed(er).

Her skriver vi; with(Grading) : +

↱

.
Quiz(et spørgsmål, og et svar) +

↱
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Efter vi har afsluttet med Enter (

↱

), generer Maple den bid, vi nu skal markere og kopiere
(den farvede del) over i elevens opgaveark. Som det fremgår af illustrationen nedenfor,
har vi, inden vi har indsat svarfeltet, givet plads til, at eleven kan skrive, hvorledes han
eller hun vil beregne opgaven (Beregning).

Vi har nu skabt den første selvrettende opgave, og inden vi fortsætter, vil vi diskutere,
hvad vi ønsker at forlange af eleven?

Hvor skal vi hen?

Hele tiden skal man holde sig for øje, hvad det ønsker, at eleven skal have ud af opgave-
typen. Er opgaven undersøgende? Er formålet faglig læsning eller træning?

I opgave 1 forlanger vi af eleven, for at kunne løse opgaven korrekt, at facit skal skrives
med benævnelse (kr.). Det er et valg der kan udelades, hvis man ønsker dette. I så fald,
bør spørgsmålet være anderledes, fx: “Hvad betaler Peter i kr?”

Andre overvejelser, der er værd at tage i betragtning, er om svarknappen [Check An-
swer] bør omdøbes og stå på dansk? [Tjek svar]

Vi vil ikke føre dig igennem, men bare nævne, at muligheden for at omdøbe knappen
finder du i kontekstmenuen til til højre, eller ved at højreklikke på knapppen og vælge
Component Properties. . . . Det er op til dig, hvor megen tid du ønsker at bruge på
at designe dine opgaver.
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Opgave 2

Opgave 2 varierer ikke meget fra opgave 1, men her skal eleven afgive og efterprøve to
svar. Opgaven lyder. . .

Opgave 2

Niels, Ole og Jens hjælper hinanden med at dele reklamer ud. Niels deler ud i 4 timer,
Ole i 5 timer og Jens i 6 timer.
De får 1200 kr. for arbejdet.

a) I hvilket forhold skal de dele pengene?
b) Hvor meget får de hver af de 1200 kr?

Vil følger samme mønster som i opgave 1. Opgaveteksten skrives i tabellens venstre side,
spørgsmål og svarmulighed kopieres fra opgavedokumentet over i tabellens højre side,
og der gøres plads til, at opgaven kan beregnes!

I opgavedokumentet forfattes de to spørgsmål. Spørgsmål 2 er af samme karakter, som
spørgsmålet i opgave 1, mens opgave 1 kræver nogle overvejelser.

Maple forstår ikke udtrykker 4 : 5 : 6 da kolon-tegnet er optaget af Maple til andre
formål. Det er derfor nødvendigt at skrive svaret som en tekst (gul markering), dette
gøres ved at skrive svaret omsluttet af anførselstegn.

Det ved eleven måske ikke, og kan ikke forstå, hvorfor Maple ikke vil svare, at opgaven
er korrekt (eller afgive et thumbs-up). Derfor kan vi vælge at give eleven et hint, der
fortæller, at svaret skal skrives i anførselstegn.

Den mest simple løsning er oftest den bedste, så vi anbefaler, at du skriver hintet direkte
i forlængelse af spørgsmålet (gul markering).
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Spørgsmål 2 følger proceduren fra opgave 1. Igen har vi valgt den simpleste løsning.
Opgaven kræver tre svar, så vi opretter tre svarmuligheder, som vi kan kopiere over i
elevens svarark.

Resultatet (se næste side) er blevet modificeret ganske lidt. Efter at have kopieret spørgs-
mål og svarmulighed over i elevens svarark, har vi valgt at tilpasse svarboksen så den
fremstår mindre.

Vi har også valgt at tilføje svarnummerering efterfølgende (a,b,c og d). Det kan lade sig
gøre, fordi spørgsmålet er en tekst. Det betyder at du efterfølgende kan rette i spørgs-
målet, hvis du efterfølgende ikke er helt tilfreds.

Ligeledes er alle svarknapper rettet til dansk. Vi kunne i den forbindelse overveje, om
det ikke ville give mening, at flytte beregningerne over i venstre side?

Som allerede nævnt, er det ikke noget du skal gøre, men noget du kan gøre. Det er et
spørgsmål om tid og effekt.
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Et lille designtip! Vil du hellere have at svarknappen står under svarfeltet, kan du markere
både svarknap og -felt, og i kontekstmenuen vælge Merge Cells, eller evt. højreklikke og
vælg; [table]→ [Merge Cells ].

Vi har nu oprettet to opgaver eleven (eller eleverne) kan arbejde med. Da du nu kender
metoden, kan vi hurtigt arbejde os gennem opgave 3.

Prøv evt. selv at designe opgave 3, før du ser på vores løsning - vi er sikre på, at det er
du i stand til, efter at vi sammen har gennemgået opgaverne 1 og 2.
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Opgave 3

Hvis du med opgave 3 er kommet frem til nogenlunde følgende opsætning, er du fanta-
stisk.

Løsningen findes fx ved at løse ligningen
8 · x
100

= 140

Lad os ændre lidt på præmissen. Hvad nu, hvis vi slet ikke er interesseret i resultatet,
men er interesseret i metoden? Hvad nu, hvis vi lavede om på spørgsmålet så det lød;

Hvor mange var ansat i virksomheden før afskedigelserne? Skriv svaret som en ligning!

Svaret er heldigvis simpelt. Quiz-svaret skal bare skrives om en ligning.

Som det fremgår af eksemplet, er Maple ligeglad med, om eleven skriver
x · 8
100

= 140,
8 · x
100

= 140 eller
8x

100
= 140, bare så længe man er enige om ligningens udformning.
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Lad os tilføje en knap, der giver mulighed for eleven at få lidt hjælp til opgaven. Det
kunne jo være, at vi havde designet opgaven således at nogle elever har brug for et hint(!)

For at tilføje en knap med et hint til eleven, skal vi tilføje en procedure (proc). En
procedure i Maple er en sekvens af kommandoer, der udføres i en bestemt rækkefølge.
Heldigvis for os, vil vi kun have proceduren til at udføre én ting; skrive et hint om,
hvordan opgaven kan løses.

Lad os antage, at vores hint til denne opgave er: Hvordan finder du 8% af x?

Vores procedure der skal skrive denne tekst, skrives således;

′hint′ = proc() [”Hvordan finder du 8% af x?”]; end proc

nb! Læg mærke til de firkantede parenteser, citationstegnene der fortæller Maple, at
det er en tekst og semikolonnet efter den firkantede slutparentes. Maple kræver at du
overholder skrivemåden.

Vi får nu følgende resultat:

For eleven vil det korrekte svar og hint se således ud;
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Opgave 4

Indtil nu, har vi kun beskæftiget os med tekstopgaver. I denne opgave kombinerer vi en
tekst med en illustration. En illustration (billede, graf, infografik etc.) indsætter man i
tabellen, ved at klikke på;

Insert → Image → FromFile

. . . og finde den illustration, man ønsker skal være til opgaven.

Opgave 4
Ved en skole er ansat 27 lærere. Søjlediagrammet viser, hvorledes lærerne fordeler sig på
aldersgrupperne;

a)I hvilken af aldersgrupperne er der flest lærere?
b) Hvad er gennemsnitsalderen for lærerne?
c) Bestem frekvensen for hver af aldersgrupperne (1 dec).

Som det fremgår af opgaven, består opgaven af oplysende tekst og et søjlediagram, der
viser aldersfordelingen af de ansatte lærere. Jeg kunne også have valgt at indsætte et
billede, fx et screenshot, der både indeholdt tekst og opgaver, fra et materiale jeg havde
lovlig adgang til at anvende.

Det eneste der adskiller denne opgave fra de tre foregående er, at der indgår en illustra-
tion, og at denne gang er et af resultaterne et decimaltal. Derfor følger vi proceduren
som vi allerede kender den; opgaven til venstre og besvarelser til højre.

Vi skal huske, at decimaltal skrives med punktum frem for komma i Maple. Det er vigtigt,
at også eleverne er trænet i dette.
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Vi skal selvfølgelig overveje, om designet med de to spalter kan aflæses. Vi må sørge for
at infografikken, i det her tilfælde søjlediagrammet, stadig kan aflæses og ikke bliver for
småt på elevernes skærm.

Hvis det er tilfældet, at infografikken bliver ulæselig af, kun at fylde en halv kolonne, så
kan man vælge at sammenflette de to kolonner i tabellen til en række.

Marker tabeller og højreklik→ Table → Merge Cells

Men i det her tilfælde er infografikken læselig.

I det her tilfælde er der sket en del efterbearbejdning i elevernes svardokument.
Knapperne er gjort danske ved at højreklikke på knappen og vælge Component Proper-
ties. . . .

Svarbokse er blevet tilpasset og har fået tildelt forklaringer (år og Grp. 1 - 5 ) og be-
nævnelser (%).

Derud over er et Hint er blevet tilføjet spørgsmål b, der skal hjælpe eleven med at finde
gennemsnitsalderen.

Hver enkelt svarboks i opgave c er oprettet med Quiz -kommandoen, men uden at knytte
et spørgsmål til, således. . .

Quiz (“ ”,svar)

. . . inden de blev kopieret over i elevernes svardokument. Vores udfordring til dig, er at
prøve, at lave en tilsvarende opgave selv.
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Et par ord om tid og forberedelse af opgaver

Tiden er knap i den danske folkeskole. Du skal være effektiv i din forberedelse, hvis du
skal nå det i din arbejdstid, for du bliver ikke betalt for at arbejde i din fritid.

Der er ingen tvivl om, at rettearbejdet er størst i udskolingen. Når du skal rette dine
elevers opgaver, så hold for øje, hvad fokuspunktet for temaet var. Her kommer de
selvrettende opgavetyper, du selv designer sig til sin ret, for du bestemmer derigennem,
hvad eleverne skal have fokus på.

Mens eleverne arbejder, kan du som underviser koncentrere din om at hjælpe dem, der
har behov for hjælp, og elever der selv kan, kan selv tjekke efter, om de har tænkt og
regnet korrekt. Det booster også motivationen og selvtilliden hos de elever, der ellers altid
skal have konfirmeret af dig, at opgaven er løst korrekt - det giver dem en mestringsfølelse
af at kunne selv.

Den tid du bruger på at forberede opgaverne er mere end betalt hjem igen, fordi du
slipper for rettearbejdet. Ind imellem, for at bevare overblikket, bliver du nødt til at
gennemse dine elevers besvarelser, men det er også hermed gjort nemmere at overskue.
Du behøver kun at koncentrere dig om de opgaver, der ikke er korrekte (eller mangler).

Correct Incorrect

I starten vil du bruge mere tid end senere. Som med alt, kommer hastigheden også med
træningen. Desto oftere du begiver dig i kast med opgaverne, jo hurtigere og nemmere
vil det blive for dig, at designe og lave opgaverne.

Med vilje har vi anvendt kiss-metoden (keep it simple, sweetie), trods det, at Maple
indeholder så mange flere automatiseringsmetoder vi også kunne have anvendt. Men
bevæger vi os ud i de mange andre muligheder, skal vi bruge mere tid til at lære fx om
forskellige procedure, og den tid mangler os, og giver os ikke nogen egentlig tidsgevinst.

Hvis man vil have mere kontrol over knapper og design, skal man kigge på pakken
with(DocumentTools). Dette ligger uden for denne booklets omfang, og hvis du er inter-
esseret, kan du selv læse om, hvordan og hvorledes i Maples hjælpemenu.

Ikke desto mindre, vil vi, efter de to næste opgaver, til sidst kaste os over en simpel
procedure, der laver den samme opgave, men hele tiden med nye værdier. Det kan især
være af nytte til træningsøjemed, hvor eleven skal træne en bestemt færdighed, eller et
bestemt tema.

Vi vil også kort gennemgå, hvordan vi laver en opgave, der hjælper eleven med at finde
ud af, om de skridt de anvender til at løse en ligning er korrekte..
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I starten af bookletten, anbefalede vi at du forberedte elevens svardokument, ved at
sørge for at dokumentet automatisk kaldte skolepakken, hvis den var installeret, eller i
det mindste Statistikpakken.

I arbejdet med de tre sidste opgaver, vil vi gøre brug af skolepakkens muligheder, dels i
forbindelse med trigonometrien, men også i forbindelse med kombinatorikken.

Opgave 5

I opgave 5 skal vi anvende trigonometri. Maple regner med radianer, mens vi i Danmark
anvender grader til at måle og beregne vinkler, derfor vil vi bruge mulighederne der
ligger i skolepakken.

Ved at kalde skolepakken (with(skole)) regner Maple i grader, hvis vi skriver Sin(x ),
Cos(x ) etc.

Opgave 5
En retvinklet △ABC er tegnet med følgende oplysninger;

a) Find vinklen B.
b) Brug trigonometri til at bestemme højden a (1 dec.).
c) Brug Pythagoras til at bestemme hypotenusen c (1 dec.).

I opbygningen af opgaven følger vi det allerede kendte mønster; opgaven til venstre og
bearbejdningen af opgaven til højre!

Også denne gang skal vi arbejde med at kombinere både tekst og grafik, men denne gang
bør vi overveje om designet i tabellens højre side, ikke skal være andeledes.

Kigger vi på spørgsmålene, ser vi at opgave a er en simpel beregningsopgave, hvis eleven
ved, at vinkelsummen af en trekant altid udgør 180o, mens de to opgaver b og c kræver,
at eleven viser sit kendskab til trigonometri og Pythagores’ læresætning.
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Vi vil derfor oprette et beregningsfelt under hvert spørgsmål til netop dette formål.

Hvert beregningsfelt er bare en encellet tabel i tabellen. Det giver os muligheden for at
se, om eleven har tænkt korrekt i sine beregninger.

Fx i opgave b kunne eleven måske forledes til at tro, at hun eller han skulle bruge cosinus
til at løse opgaven. Man kunne derfor også evt. overveje et hint her, og evt. overveje,
hvis man anvender skolepakken, at minde eleven om at skrive Tangent med stort T. Hvis
man ikke anvender skolepakken, kunne man give et hint om, hvordan man omregner fra
radianer til grader.

18



Opgave 6

Opgave 6 er ikke besværlig, og i dette øjemed kun medtaget fordi du skal have muligheden
for at øve dig. Opbygningen følger næsten den opskrift vi allerede kender (og elsker).

Du har sikkert allerede spottet, at opgaven står i venstre side, frem for højre side. Det er
fordi vi her simulerer, at opgaven er et screenshot, hvor tekst og billede hænger sammen.

Vi har altså valgt den mest enkle tilgang. Et screenshot kopieret ind i tabellens venstre
side, og beregningsfelt (tabel i tabel) samt svarboks i højre side.

Kombinatorikformlerne kan være svære at huske. Derfor finder man i Maples skolepakke,
forenklede kombinatorikkommandoer til at hjælpe eleven med at huske, hvad man skal
gøre.

Ikke at du skal bruge en af formlerne i ovenstående opgave, men prøv selv at finde en
kombinatorikopgave, tag et screenshot og byg en opgave op. Afprøv evt. din opgave med
en af kommandoerne fra skemaet!

God fornøjelse.
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Opgave 7

Ind til nu, har vi beskæftiget os med design, beregningsfelter, svarbokse og knapper. I
opgave 7 vil vi bruge Multiple Choice. Eleven præsenteres i eksemplet for tre valgmulig-
heder, og skal afkrydse den korrekte graf der viser f(x) = 2x+ 2.

Den type af opgaver stiller os i lidt af et dilemma, for hvad afholder eleven fra ikke bare
at forsøge sig frem, ind til at Maple svarer Correct?

Igen må vi ty til en tabel i tabellen, altså et forklaringsfelt, hvor eleven skal forklare,
hvorfor svaret er korrekt. Det forhindrer ikke eleven i at prøve sig frem, men eleven er
nødt til, i det mindste at forholde sig til opgaven.

Opgaven bygges op, som vi kender den. Oplysninger i venstre side, opgave i højre. Først
indsættes graferne.

Dernæst indsættes Multiple.Choice-opgaven i højre side. Opgaven er en smule mere
kompliceret at skrive, fordi Maple skal have at vide, hvor mange muligheder der er at
vælge mellem, og at du ønsker at bruge Multiple Choice.
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For at lave en Multiple-Choice-opgave skal man skrive følgende;

Quiz ("dit spørgsmål" , svar , [valgmuligheder ] , ’style’=’multiplechoice’]

Lad tage det bid for bid, først spørgsmålet og svaret -helt som vi plejer.
Quiz ("Hvilken af de nedenstående grafer viser funktionen f (x) = 2x + 2?", 1 ,. . .
- vi ved jo, at graf figur 1 er det korrekte svar!

Dernæst skriver vi valgmulighederne 1, 2 eller 3.
Quiz ("Hvilken af de nedenstående grafer viser funktionen f (x) = 2x + 2?", 1 ,

[1,2,3],
Vi kan vælge mellem tre figurer, fig. 1, fig. 2 eller fig. 3. Derfor skriver vi [1,2,3] i firkantede
klammer. De firkantede klammer skal skrives.

Vi slutter af med, at fortælle Maple, at vi vil have den laver en Multiple-Choice-opgave.
Læg mærke til, at i Maple skal du skrive enkelt-citationstegn rundt om style og mul-
tiplechoice
Quiz ("Hvilken af de nedenstående grafer viser funktionen f (x) = 2x + 2?", 1 ,

[1,2,3],’style’=’multiplechoice’)
Efter at have afsluttet med Enter (

↱

), får vi følgende resultat;

Og vores opgave begynder at tage form.
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Det eneste vi mangler nu, er at placere en tabel i tabellen til elevens forklaring.

Således blev alle opgaverne til eleven færdige. Opgave 1 - 7. Du har beskæftiget dig med
simple opsætninger (simpelt design) i to spalter, med kommandoen Quiz og nogle af
dens muligheder.

Vi har diskuteret forskellige opgavetyper, faldgruber og tidsforbrug, vi har kigget på
procedure, hint og det at undervise med selvrettende opgaver. Du burde nu være i stand
til, at designe og opstille dine egne opgaver til dine elever, ved at dele dokumentet de
skal arbejde i, fx i Maple Cloud.

De to næste kortfattede opgaveeksempler kan du springe over, hvis du synes, men hvem
ved, måske kan du bruge dem?
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Løs en ligning

Maple kan løse opgaver med ligninger automatisk, med den fare at eleven ikke ved
hvordan man gør!

Heldigvis er der en funktioner i Grading-pakken, der kan hjælpe eleven med at træne
netop den færdighed; SolvePractice!

Selve opgaven kræver kun to linjers kodning.

Opgaven beder eleven om at vise, hvordan man løser ligningen 2x + 3 = 4x − 5, med
hensyn til at finde x.

Outputtet skal der kæles lidt om, hvis man ønsker at overskrift og knapper skal stå på
dansk. Som altid, skal man vente med at gøre dette, ind til, at man har kopieret opgaven
over i elevens arbejdsark.

Et forslag til layoutet kunne være som det vises herunder. Ikke smukt, men effektivt og
nemt. Prøv selv at lave en opgave.
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Prøv igen med en ny opgave

Det er muligt for Maple at indsætte og kalde tilfældige værdier i spørgsmål til eleven,
ved at navngive variablerne med et $-præfiks.

Det vil vi drage nytte af. Vi kan skabe en type af opgaver der gentager sig selv, men med
nye tal der skal beregnes. Vi vil først kigge på et eksempel, hvor eleven skal beregne
summen af to tal mellem 0 og 100.

Vi skal sammen bryde kodningen(!) op i små forståelige bider, således at du med denne
intro kan genskabe opgaverne af typen 1 - 3, primært fordi disse opgaver repræsentere
simple regneoperationer, der alle er nemme at tildele nye variable der kan beregnes.

Start
Vi starter med at hente pakken Grading og stille spørgsmålet;

Dollartegnet ($) fortæller Maple, at den skal hente to tilfældige værdier, en værdi navn-
givet A og en værdi navngivet B.

Den næste kodelinje er den svære, men lad os prøve at bryde den ned i små overkommelige
bider.

( ) → Parentesen er pladsholder for den løsning du skriver. Løsningen hentes (Get) fra
pladsholderen, og sættes til at være svaret (`$Response`) og ind i quizzen (Quiz:-). Om
(`-tegnet, se illustration.)

=Quiz:-Get(`$A`) + Quiz:-Get(`$B`) henter og sammenligner summen af de to tilfæl-
dige tal A og B med den sum eleven har udregnet. Er resultaterne ens skriver Maple
Correct, er de ikke ens skriver Maple Incorrect.
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Nu mangler vi bare at skrive en procedure der kan hente og tildele A og B to tilfældige
værdier, dette gøres med kommandoen rand .

Vi starter proceduren ved at skrive proc(); Dernæst beder vi Maple sætte (Quiz:-Set
værdien A til en tilfældig værdi mellem 0 og 100 (rand for random) =rand(0..100)( ) -
det samme for værdien B. Vi slutter proceduren af med end)

Vi er færdige, alle tre linjer ser således ud i sammenhæng og giver følgende resultat. . .

Opgave 1 igen

Lad os prøve at anvende vores nye færdigheder til at rekonstruere opgave 1.

Der er udsalg i en en boghandel. Peter køber 2 kriminalromaner til 45 kr. pr. stk., 5
tegneserier, hvoraf de 3 koster 39 kr. pr. stk., og de to koster 53 kr. pr. stk.

Hvor meget betaler Peter i alt?

Vi beslutter os for at lade priserne variere fra mellem 20 og 60 kr. Vi skal altså konstruere
opgaven med tre variable.
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Hvis vi opbygger vores opgave på denne måde, har vi behov for at nytænke designet.
Her giver det ingen mening at arbejde med to kolonner. Vi vælger derfor at samle hele
opgaven i én kolonne, og får, efter lidt tilpasning, følgende resultat:

Der er en ny knap (Prøv en ny opgave). Når eleven klikker på knappen, genererer Maple
en ny opgave. Vi kunne have valgt også at lade antallet af bøger og tegneserier variere
ved at erklære nogle flere variable, men det er en opgave jeg vil overlade til dig at pusle
med!

Slutord

Vi har sammen kæmpet os gennem denne lille booklet, og vi håber at den giver dig
inspiration til at konstruere og arbejde, og ikke mindst lade eleverne arbejde, med selv-
rettende opgaver.

Formålet med øvelsen var, at ved at lade eleverne arbejde med de selvrettende opgaver,
frigjorde du noget undervisningstid til de elever, der har behov for det.

I starten vil du synes at det er omstændeligt. Men med øvelsen går det hurtigere og
hurtigere, og endnu hurtigere går det, hvis du gemmer noget af kodningen som en task,
så er meget af kodearbejdet kun et klik med en mus.

Vi håber du har nydt at gennemgå opgaverne, og det har været vores fornøjelse at vise
dig, at det let lader sig gøre.
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Følgende opgaver forholder sig til læseplanen for matematik 2019, men gør ikke krav på
at være dækkende.

Opgave 1
Der er udsalg i en en boghandel. Peter køber 2 kriminalromaner til 45 kr. pr. stk., 5
tegneserier, hvoraf de 3 koster 39 kr. pr. stk., og de 2 koster 53 kr. pr. stk.

Hvor meget betaler Peter i alt?

Opgave 2
Niels, Ole og Jens hjælper hinanden med at dele reklamer ud. Niels deler ud i 4 timer,
Ole i 5 timer og Jens i 6 timer.
De får 1200 kr. for arbejdet.

a) I hvilket forhold skal de dele pengene?
b) Hvor meget får de hver af de 1200 kr?

Opgave 3
I en avis står, at en fabrik måtte afskedige 140 arbejdere, svarende til 8% af de arbejdere,
der var ansat i virksomheden.

Hvor mange var ansat i virksomheden før afskedigelserne?

Opgave 4
Ved en skole er ansat 27 lærere. Søjlediagrammet viser, hvorledes lærerne fordeler sig på
aldersgrupperne;
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a)I hvilken af aldersgrupperne er der flest lærere?
b) Hvad er gennemsnitsalderen for lærerne?
c) Bestem frekvensen for hver af aldersgrupperne (1 dec).

Opgave 5
En retvinklet △ABC er tegnet med følgende oplysninger;

a) Find vinklen B.
b) Brug trigonometri til at bestemme højden a (1 dec.).
c) Brug Pythagoras til at bestemme hypotenusen c (1 dec.).

Opgave 6
Simone og John skal på ferie. De kan vælge mellem 7 forskellige feriedestinationer, og de
kan vælge imellem at rejse med tog, fly eller bus.
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Opgave 7
Hvilken af de nedenstående grafer viser funktionen f(x) = 2x+ 2?

29


